
 

 

 

  

This Is unfinished rough draft on collaborative writing intended but not incorporated into a 

published book. I wrote the draft in September 2006 and did some editing in March 2014. I am 

placing this draft in the public domain. Anyone can use it, modify it, or do anything they wish 

with it.  – David K. Farkas 

Chapter 8.  Writing Teams 

8.1 Introduction 

There are many kinds of teams in the worlds of technology and business. Some teams work 

together to examine a problem and make a decision. They may produce a written record of their 

deliberations, for example meeting minutes. But such documents are incidental to their work. In 

many other instances, a document is an important secondary outcome. For example, if a team 

deliberates for weeks to devise a complex plan, they will very likely invest time writing a 

document that explains the plan. For still other teams, a document is the primary outcome—for 

example, a team that works together on a proposal or an academic paper. 

 

The first part of this chapter discussed teams in general. Now we will look at teams for 

whom the primary or secondary goal is creating a document. We will examine how a team plans 

a document, in particular the ways in which they ensure that the finished document will be a 

unified whole. We will also look at how teams typically divide up the job of drafting the 

document and the stages of review and revision. Finally, we will look at an important activity in 

team writing: document annotation. This means adding comments directly to a draft and 

indicating revisions. To prepare you to work effectively on writing teams, we will show you a 

range of techniques, many computer-based, for annotating documents. 
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Very often an important outcome of a team project is creating a document. Teams, therefore, 

must effectively plan, draft, review, and revise documents. One special challenge of team 

writing is ensuring that the document is a unified whole. To work effectively in writing teams, 

team members must know techniques for document annotation. 

 

8.2 Developing the Common Image 

When a team begins to plan a document—say a proposal—they share ideas about the 

document. The team’s collective vision of the finished document can be called the “common 

image.” Unless the team establishes and then maintains this common image, the document will 

suffer from disunity. A disunified document will probably not achieve its goals, and the authors 

will appear careless, inept, or both. Furthermore, when there is no common image, there is likely 

to be confusion and dissension among team members. 

 

The common image encompasses everything about how the document will be written. This 

includes the following: 

 

 The team’s idea of who the audience is and what the audience wants 

 The overall approach and persuasive strategy. For example: Should we disparage or just 

ignore the competition? 

 The length of the document and the length of each section 

 The writing style 

 The formatting. For example, headings and spacing 

 The writing conventions. For example, when numbers should be spelled out and when they 

should be figures. 

 

Not everyone on the team needs to be an expert or a leader regarding every aspect of the 

document. But everyone has to know enough and care enough so that the common image is 

maintained. 
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How does a team establish a common image? Mostly through discussion and decision-

making. Very often the team leader (or some other expert on the team) opens the discussion and 

sets forth his or her vision of the document. Everyone, however, should have a chance to 

contribute their ideas, and everyone’s ideas should be listened to carefully. In other instances, the 

common image may come about “bottom up,” with no leader or boss leading the discussion. This 

might happen, for example, if the team delegates a writing task to two or three members of 

approximately equal expertise and status.                                                             

                                                    

Although discussion is very important, at some point decisions must be made. The team 

leader may make the decisions, or decisions may be made by consensus. Experts at Microsoft 

who study teamwork say that there are moments for divergence, when you are looking for fresh 

ideas, and moments for convergence, when you get behind one set of ideas. The team, then, must 

find the appropriate moment to converge around the common image and a plan for creating the 

document. 

 

In regard to format and conventions, there is usually an existing standard that must be 

followed. Or, possibly the team will choose between standards or even create its own standard. If 

you have been reading this book chapter by chapter, you know quite a bit about standards for 

formatting. 

 

Below are various strategies that help a team create and maintain the common image. You 

can employ one or more of these strategies in any team writing project. 

 

 Create an outline 

 Follow a model document 

 Use a template for formatting 

 Follow a standard (the “house style”) for formatting and writing conventions 

 

A team writing project will fail unless everyone fully understands and buys into the common 

image. The team, therefore, needs strategies for creating and maintaining the common image. 

Usually the team will need to follow a standard for format and conventions. 
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8.2.1 Creating an Outline 

An outline is a one of the most important techniques for creating a document’s common 

image. Creating and refining an outline is how a team plans out and records the major ideas that 

will make up the document and the way these ideas will be organized into sections and 

subsections. We recommend creating an outline using the Outline view of MS word (or another 

word processor). In Chapter XX, Effective Writing, we explained how to use MS Word’s 

outlining feature. With the outliner you can re-arrange the outline very quickly, and you can 

project the outline on a screen during meetings. Alternatively, you may prefer to simply write a 

scratch outline with a pencil or use some other means.  

 

An important decision is whether you will expand your basic outline by adding body text to 

some or all of the outline entries. An expanded outline, shown in Figure 1, captures more of the 

group’s thinking. One good idea is for the team to collectively brainstorm a basic outline and to 

assign one team member to expand the outline based on the team’s ideas.  

 

 

Figure 1. Outline entries expanded with body text. The elaborations on the outline 

entries are written in the informative style 

 

When you write the expanded outline, you can write in two styles. The descriptive style  

describes (or “promises”) what the final document will contain: 
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This section reviews the experimental literature on corrosion of low-carbon steel. 

 

The informative style conveys (rather than promises) actual information: 

 

The experimental literature on the corrosion of low-carbon steel shows that low-

carbon steel is especially susceptible to high humidity. It also shows . . . .  

 

Informative summaries require more work than descriptive summaries. The advantage is that 

they force the team to really think out its ideas. You can also use both styles together. For 

example, you can use the descriptive style to summarize the more routine parts of the document 

and use the informative style for the tricky parts, the parts you really want to see written out. Or, 

if you’re not ready to work out certain ideas in detail, the descriptive style is a good way to 

postpone these issues for later. 

 

You can establish the common image with either a basic or an expanded outline. Outline 

entries can be either descriptive or informative. 

 

8.2.2 Following a Model Document 

Another way to develop the common image is to find an existing document to use as a 

model. An appropriate model provides concrete example of how many kinds of writing issues 

can be handled. These issues include the level of technicality, how to explain the experimental 

procedures, and the look and feel of graphics. There is nothing unethical about using someone 

else’s writing as a general model for your work. It is also possible that the team will identify 

some aspects of the model document that they don’t want to follow. It’s desirable to find a model 

with strong similarities to the document you are writing. If your team is writing a proceedings 

paper. It makes excellent sense to examine a high-quality paper from the previous year’s 

proceedings.  
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One problem with collaborative writing is that we don’t have a good vocabulary for 

describing some important aspects of writing, among them writing style. We can talk generally 

about a direct style or a flowery style or a casual or formal style, but it is not easy to specify 

exactly what makes up each of these styles. Models can help a team settle on a consistent style. If 

the team agrees that they like the style of writing used in the model, everyone can use that style 

as a point of reference for their own writing.   

 

Follow an appropriate model. Be explicit about which aspects of the model you are following 

and which you are departing from. One benefit of models is helping the team write in a 

consistent style. 

 

8.2.3 Using a Template for Formatting 

High-quality documents are consistent. Indentation, line spacing, and a great many other 

formatting issues are treated consistently throughout. Numbered elements such as headings and 

equations do not have glitches such as duplicate or missing numbers. Consistent formatting, 

therefore, is part of the common image. One of the best ways to achieve consistent formatting, 

especially when multiple people are working on a single document, is to “enforce” consistent 

formatting with a template. If the team changes its mind about formatting, global changes can be 

made very easily. 

 

Templates are ideal for scientific and technical documents. They should cover headings, 

equations, figures, tables, the table of contents, and special document elements such as 

acknowledgements and authors’ bios. Templates should also include tips about the content of 

certain document components and the best way to write them. 

 

Consistent formatting is part of the common image. Templates—and the T-Magic templates 

especially—are ideal for achieving consistent formatting. 
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8.2.4 Following a standard (“house style”) for formatting and writing 

conventions 

Because we must often write to standards, one important aspect of the common image is the 

particular standard that applies to your document. Particular disciplines, professional societies, 

conferences, journals, and commercial publishers often insist on a particular standard for the 

documents they publish. Likewise funding agencies often insist on a standard for the proposals 

they review. The particular standard established by a particular discipline, publisher, or other 

entity is often referred to as the organization’s “house style.” So, for example, IEEE has a “house 

style” for its journals.  

 

An organization’s house style covers formatting and very likely writing conventions, such as 

when to use figures vs. spelled numbers and how to use acronyms. Templates not only enforce 

consistency, but the formatting they enforce is close to the house style of most publishers and 

other organizations in engineering and the sciences. Also, the writing conventions explained in 

Chapter XX of this book, (Writing: Rules and Conventions) will almost certainly be close to the 

writing conventions you will be asked to follow. 

 

Even when you are not required to follow a house style—for example, in the case of an 

internal document—a team will do well to follow (or establish) a standard for formatting and 

house style, just to keep the document consistent.  

 

The common image includes adhering to any required formatting and writing conventions, the 

“house style.” Even when there are no such requirements, it makes sense to follow or establish 

a standard. 

8.3 Fighting Drift 

Once the planning process is finished, it’s time to actually write—to create a draft of the 

document. One of the challenges in the drafting stage is fighting drift. Drift is the tendency to 

diverge from the common image. You can think of drift as entropy in a system. It is very easy to 

lose track of some aspect of the common image. For example, it is easy to forget that the team 
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has agreed to write longish figure captions in order to keep the body of the document trim and 

easy to read. Such relatively minor instances of drift can be fixed in the editing stage—but why 

create extra work for other people? Other forms of drift, such as taking an entirely unexpected 

approach to the discussion of the experimental data, are far more disruptive. 

 

How do we fight drift? Just as you might expect: Individuals must focus on the common 

image, and the team must periodically conduct reviews to “recalibrate” their efforts and ensure 

that everyone is still “on the same page.” So, for example, someone might say, “Did anyone see 

any drift in the latest draft?” 

 

In some situations it is reasonable for a team member to propose a different approach after 

the project is underway. Let’s say your job is to do the statistical analysis, but you’ve come up 

with a new approach. You might want to come to the next meeting with both the expected 

analysis and your new idea. In this way, the team can quickly weigh the pros and cons of the two 

alternatives. Furthermore, if your idea is not accepted, you haven’t slowed the team down. 

Finally, there is always the possibility that your team is doing something seriously unethical or 

illegal. In such cases you ought not follow along. But, especially in such cases, you should make 

your disagreement and refusal known to the group. 

 

The biggest enemy of the common image is drift, the tendency to diverge from the common 

image. We must fight drift throughout the project. 

8.4 Organizing the Team’s Effort: Divide and Draft 

The usual procedure for drafting a document can be called “divide and draft.” This means 

that individual team members are assigned to write a section (or sections) of the document. 

When the sections have been drafted, they will be reviewed, probably by the team leader or 

possibly by all members of the team. The main purpose of the review process is to determine 

what further changes need to be made. In other words, reviewing leads to the process of revising 

the draft, and you will probably be asked to revise your draft section. 
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There are, however, many variations on the basic divide and draft procedure. Here are just a 

few: 

 Reviewers often find it easier to make certain changes themselves, and so reviewing often 

includes some revising by the reviewer. 

 If a draft is reviewed harshly, it may not move forward into revision. Instead, the reviewer 

may call for a new draft and may even assign it to another person. 

 Drafters may conduct informal “pre-reviews.” For example, Sue may ask Sam to take a look 

at her section before it goes to the team leader. 

 

Note that there are always just four fundamental team writing activities: planning, drafting, 

reviewing, and revising. A savvy team will perform these activities in whatever ways make the 

most sense to them. 

 

Here are some guidelines for carrying out your responsibilities during the drafting stage: 

 

 When you draft, focus your attention on how your section will fit with the rest of the 

document. 

 If you are asked to revise your draft, make changes that are truly responsive to the review 

you just received. This can be difficult if some of the changes you are being asked to make, 

don’t match your own preferences. Consider, however, that there cannot be an effective, 

unified document unless everyone is willing to adhere to the common image. 

 Do everything possible to submit your draft and your revised draft by the agreed-upon 

deadline. 

 

The usual procedure for team writing is “divide and draft.” There are many possible variations 

on basic divide and draft, but they all entail various combinations of planning, drafting, 

reviewing and revising. 
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8.5 Other Ways to Draft: Solo Drafting and Collective 

Drafting 

We will take a quick look at the two alternatives to divide and draft, because each one is 

useful in particular circumstances. These are solo drafting and collective drafting. In the case of 

solo drafting, one person drafts the entire document. This person functions as the staff writer for 

the team. The solo drafter needs a very thorough understanding of the entire project. At times the 

solo drafter will be the team leader. A big benefit of solo drafting is consistency. The draft will 

be written in one style and with one set of habits regarding writing conventions. Also, the team 

may have one truly outstanding writer. A big drawback is that the drafting goes more slowly than 

when multiple people share the load. But if there is enough time, solo drafting may be the best 

plan. Once the draft has been written, it should be reviewed and revised. 

 

Collective drafting means that two or more people draft together. They may cluster around a 

computer or may sit at a table with the draft projected on the screen. The drafters may also be 

physically separated and share a digital workspace such as Microsoft NetMeeting. Or, they may 

use Instant Messaging or just a flurry of emails. In collective drafting, everyone contributes 

ideas, suggests phrases and sentences, and critiques what’s been written. There is no real 

separation between planning, drafting, reviewing, and revising. 

 

The big drawback here is obvious: the enormous investment of time. Collective drafting, 

therefore, is almost always used when a team is writing something short and very important—for 

example, a statement of project goals, a set of research hypotheses, or crucial wording in the 

discussion of an experiment. The benefits of collective drafting are that you are getting the 

group’s best thinking at a very fine-grained level. Also, collective drafting promotes “buy-in,” 

(agreement regarding the final product) by those who took part in the drafting effort. 

 

Two alternatives to the divide and draft procedure are solo drafting and collective drafting. 

Solo drafting promotes consistency. Collective drafting gives you the group’s best thinking all 

through the drafting process. 
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8.6 Copyediting and Goofproofing 

Copyediting and goofproofing comprise the final phase of revision. Copyediting means 

polishing. The editor focuses on the best possible wording, achieving consistency, and adhering 

to house style. If there are larger problems, such as a poorly organized paragraph or an unclear 

explanation, the editor should deal with these as well. The editing process also includes checking 

to see that graphics are attractive and communicate their meaning. 

 

A key point about copyediting is that one person should copyedit the entire document. It is 

very difficult for two different people to handle all the copyediting issues in exactly the same 

way. A team may also choose to have more than one person independently copyedit the 

document and then compare what they have done. If there is time and money in the budget, the 

team may want to bring in a professional copyeditor. Once the team has reached the copyediting 

phase, everyone should start feeling that the end is in sight, and everyone should be proud of 

what they’ve accomplished. 

 

Goofproofing is a final check to guard against oversights such as missing or misnumbered 

figures. If the manuscript cannot be released without an official sign-off, goofproofing includes 

checking that the appropriate signatures have been obtained. If the manuscript will be distributed 

in paper form, goofproofing includes a check on the quality of the photocopying or printing. If 

the document will be distributed in digital form, goofproofing includes a check on file 

conversions, such as ensuring that nothing has gone wrong then the Word file was converted to 

an Adobe Acrobat file (PDF). You need a careful, systematic person (or more than one) to 

goofproof a manuscript. Any team that doesn’t take goofproofing seriously is playing Russian 

roulette! Appendix A is a comprehensive checklist for editing and proofreading.  

 

The final stage of revision consists of copyediting and goofproofing. Copyediting 

means polishing. Goofproofing means checking for oversights. 
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8.7 Techniques for Document Annotation 

The term “document annotation” refers to writing  comments and indicating changes 

directly in a document. When someone reviews a draft, they might communicate their responses 

orally or perhaps by sending an email message, but more than likely they will prefer to annotate 

the document. Various annotation procedures are explained below. 

 

8.7.1 Annotating hardcopy: informal annotation, editing symbols, and 

correction codes 

The simplest annotation procedure—what we call “informal annotation”— is to mark 

revisions and write comments on a printout of the draft. Words and passages can be crossed out, 

and inserted words can be handwritten between the lines or in the margins. The reviewer can 

indicate changes in any other way that will make sense to the team. If you’re careful and neat, 

this approach will work in many situations. 

 

There is also a set of editing symbols that have been used for many years in the world of 

publishing. A convenient subset of the traditional editing symbols is shown in Figure 2. 
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Figure 2. A useful subset of the traditional editing symbols. 

 

These symbols, once you’ve learned them, are more efficient than informal marks because they 

give you a rich vocabulary for marking revisions. For example, to show that a lower-case letter 

should be upper-case, a professional editor simply adds a triple underline, and everyone in the 

publications world understands what the editor wants. To show the same thing using informal 

revision marks will take more time. If your work is professionally edited, you may well see these 

symbols. Also, publishers often require authors to use the traditional editing symbols (or 

proofreading marks, a close relative) to indicate any changes they want to make in a manuscript, 

especially once it’s been typeset.  

 

Another annotation technique is the use of correction codes. Correction codes differ from 

editing symbols in that they don’t specify exactly what changes should be made. Rather, they 

point out a problem but ask the reviser to figure what to do. Corrections codes can cover such 

issues as these: 

 

 Spelling error 

 Possible spelling error (please check) 
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 Typo 

 Awkward passage (“Awk”) 

 Unclear 

 Fuzzy (clear but  vague or hard to figure out) 

 Unsuited to audience 

 Formatting 

 Pronounce reference 

 Format problem 

 Let’s talk 

 End of review (“I didn’t go further into the document than this.”) 

 

It is easy to decide upon an appropriate abbreviation for each of these problems and to create 

an distribute a key explaining each code. Another useful idea is a “global” correction code, 

which means that the problem recurs often the manuscript and the reviewer will no longer point 

out instances of this problem. Place a “G” or other abbreviation after one of the other corrections 

codes to indicate that it’s a global problem. 

 

 

 

Correction codes can be used with both informal annotations and editing symbols. Usually, they 

are handwritten, but they can also be typed. To more strongly distinguish editing codes from 

editing symbols and other comments, you can add the letter C and a colon before each correction 

code—like this: C: sp 

 

When you work on paper, you can mark changes by means of informal annotation or 

traditional editing symbols. Reviewers can use the correction codes to indicate the changes that 

revisers should make in their drafts. 

 



 

15 

 

8.7.2 Marking revisions and commenting on the computer 

Although a busy team leader reviewing a draft may want to handwrite changes on hardcopy, 

there are many advantages to reviewing and revising on-screen. Consider, for example, that 

paper marked with ink or pencil cannot be distributed via email or posted to a wiki. Also, a paper 

document cannot be spell checked or otherwise changed. Below we explain some very useful 

ways to add comments and indicate revisions using the computer. Here we are assuming that you 

are creating your documents using Microsoft Word, but these features may be found on other 

word processors. 

 

8.7.2.1 Using Word’s Comment feature to add comments to the text 

MS Word’s comment feature is easy to use and has lots of convenient options. For example, 

you can display comments in the comment pane at the bottom of the main text window or in 

comment bubbles. The comment pane is shown in Figure 3 along with insertions and deletions 

added with the change tracking feature. 

 

 

Figure 3. Comments added in the Comment pane and examples of change tracking. 
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When you use the commenting and change tracking features, you will generally start by 

displaying the Revision toolbar. You can work faster with when this complete set of controls is 

available. 

 

To display the Reviewing toolbar: 

1. Right-click a blank area on any toolbar you are currently displaying. Word will display the 

full list of toolbars. 

2. Click Reviewing.  

Note: You can add a comment without displaying the Reviewing toolbar by clicking 

Comment on the Insert menu. 

 

To add comments from the Reviewing toolbar: 

1. Select the text you wish to comment on. 

Note: Don’t place the mouse pointer between characters. Comments are hard to work with 

unless at least one character has been selected. 

2. On the Reviewing toolbar, click Insert Comment. 

 

The selected text will be highlighted and a comment number and the commenter’s initials 

will appear. 

Note:  In Word 2002, vertical red comment indicators will appear where you selected the 

text. 

 

3. If you are in Normal view, type your comment into the comment pane at the bottom of the 

window. If you are in the Print Layout or Web Layout view, type directly into the 

comment bubble. 
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Note: To close the comment pane, click the Reviewing Pane button on the Reviewing 

toolbar. 

 

If you are in Print Layout or Web Layout view, hide the comment bubbles by switching to 

Normal view. 

 

To identify yourself as the author of comments and tracked changes: 

1. On the Tools menu, click Options and then click the User Information tab. 

2. Type your name and initials in the text boxes. 

 

To view comments: 

 On the Reviewing toolbar, click Reviewing Pane. 

 

-or- 

Switch to the Print layout or Web layout view (on the View menu). 

 

To edit a comment: 

 On the Reviewing toolbar, click Reviewing Pane and then type directly into the reviewing 

pane.  

 

-or- 

Right-click the highlighted text that you have commented on and click Edit Comment on 

the pop-up menu. 

-or- 
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Switch to Web Layout or Page Layout view and type directly into the comment bubble. 

 

To delete a comment: 

 Right-click the highlighted text that you have commented on and click Delete Comment on 

the pop-up menu. 

-or- 

 In Web Layout or Page Layout view, right-click the comment bubble and choose Delete 

Comment from the pop-up menu. 

 

To manage a set of comments: 

 To cycle through a set of comments, on the Reviewing toolbar click the Previous and Next 

buttons (the left and right arrows). 

 To hide your comments and all text highlighting associated with your comments, on the 

Reviewing toolbar click the Show menu and click the Comments option to clear the 

checkmark. 

 To delete all the comments in a file, on the Reviewing toolbar click Reject Change/Delete 

Comment and then click Delete All Comments in Document. 

 

8.7.2.2 Using Word’s Change Tracking Feature to Indicate Revisions 

Very often we don't need to make comments on a draft. We simply want to indicate a 

proposed change in the manuscript. Why “proposed”? If you are working on your own document 

and you wish add or delete something, you can simply do this in the normal way. However,  

when you are working in a team, you very often must use the Change Tracking feature in order 

to leave a record of your changes and enable your changes to be reversed. When you work with 

Change Tracking and you are in Normal view, insertions are marked with underlining and 
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deletion are marked with strikethrough. In Web and Page Layout views, insertions and deletions 

are shown a little differently. 

 

To turn on the change tracking feature: 

 In the status bar (at the bottom center of your MS Word window), click the TRK button. 

Click again to turn off Change Tracking. 

 

Note: Many writers switch in and out of Change Tracking mode regularly as they work 

with a document. You will develop your own strategies and tricks. 

 

To select the appropriate Change Tracking mode: 

The list box at the left of the Revision toolbar shows the four Change Tracking modes: Original, Original 

Showing Markup, Final, and Final Showing Markup. Make the choice that suits your work habits and 

what you’re doing at a particular time. 

 Click Original Showing Markup (or Final Showing Markup) to see your tracked changes 

marked with strikethrough and underlining.  

 Click Final to get an uncluttered view of the document with all the changes have made. 

 Click Original for a view of the original document. 

Note: the change tracking modes function somewhat differently in Web Layout and Page Layout views. 

 

To accept and reject tracked changes: 

 Right-click the text that has either change track strikethroughs or underlines and make the 

appropriate choices on the pop-up menu. 

-or- 

On the Reviewing toolbar click the toolbar buttons for accepting and deleting tracked 

changes and make the appropriate choices. 
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Note: You can cycle through a set of tracked changes by clicking the Previous and Next 

buttons on the Reviewing toolbar. 

 

To change the appearance of balloons and tracked changes: 

 On the Tools menu, click Options and then the Track Changes tab.  


